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- Content Providers (Junguuasgamdenlalunmsiindsdoyavoaonnamsuou v
Thuewnamduae awnsousudoyanuld
. I 1 o & Ao ~ @ 9 9 A
- View System !Hunquussgamasnsamsmneint Inssadevesntinsefudawaly
' a 1 o ] U = <
AuAAABNUR1F (User Interface) 1971 1Ju, Text box 130 list 11luAw
I ) o v { o I'd ]
- Telephony Manager tiunguussgaidenlelumsiiinedoyadiuinsdnn wu
o J I
waneay Insans udu
I ' o W a & Ay 19 1
- Resource Manager [Junguvasgamdelumsiiitatoyalutonnamsui lulylna
' 9 < 9
wuIeANNLaz W 1uau
. < 1 o & v o 1 a oA a wa
- Location Manager [Junguassgamdunernudumianugimeaainszuulguans

1a5uarnngilnsal
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5. Application
v 9 H Y 1
ﬁauawwam%ummmﬁmmmﬂmﬂ?maguﬁ’awu Phone dialer, Email, Contacts,
I 9 =< Aa J A ya ¥ A & Aa <
Web browser i8¢ Google play 1uau i’JiJf]\TLLE’JWWﬂLWBH‘ﬂF}ﬂ%@]ﬂ@\iLWNL@Q SEALDWNALATU

2 A Ay
Navua luaIulaz@Weua18n181911

A A Y v a o a wva d
2.1.3 !ﬂif’)\iuﬁ)m‘muﬂ15‘W9)lu1!!ﬂ‘W1Nﬁl!ﬂ‘UHUH?%UUﬂQUﬂﬂ'ﬁ!!@‘Hﬂiﬂﬂﬂ

2.1.3.1 Java Runtime Environment (JRE)

AoTilsunsudmfulssnamamuvava  1¥dmsumsiuTsunsuiildnenly
mswan Taglszneuds Java Virtual Machine VM) @avmnthiinalas byte code 171510
ATHUAT BB CPU A4 platform M ttazi) runtime library Uszneunsiaimuealilsunsa
ug JRE uenunsarh 1l umswannlysunsuld ms1gana  Development tools 134
compiler(javac.exe) Interpreter (java.exe) HaY debugger (jdb.exe) unnzams m?ﬁlm

A A D) A A 0
AouInes Nz 1w nnedlug class file od19R8 AN

2.1.3.2 Eclipse IDE for Java Developers
o =y
Eclipse noozls
. A L A Yo
Eclipse Ao ldsunsuilszian IDE (Integrated Development Environment) A1a5unnu
< ' { o < s ¢
aulailuedrsuinningndssnisiaun Tsunsua1o0181 Java naziiluwonanas Open
{ o 3 4 v W ) @ . <
Source ANVl laeinauues i lanudvihlumsiannves Ectipse 1l

] 1 4 <3
ﬂﬂ?ﬂﬁ@iﬁ@ﬂ!m%iﬂﬂlﬁ?

. .
=eclipse

INDIGO
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4 [ { 1 ) [ 4 1

Eclipse H09AU52nounaniizondi Eclipse Platform 1115150 INAT0A199910

) ) o ' @ v = Y a s A a '
meusnlnasaivhauunuluannuiadeufedny taziiesalszneuinizonii
. . £ q 9 2 o s ¢
Plug-in Development Environment (PDE) &4 14 1lumsmuanuaunsolumsnanngenanas
2 A o A a 1 . . v o v v
WINTY 1n0INeMenenazgnia IugUuuuNTeNI Eclipse plug-ins A91UHINABING 14

o 2 a =] Y | ) [ LA 1 o . £

Eclipse i1 lamiaay nilleauaiaiu plugin @115 091U UUAUIN 4agiil Plug-in U

a & A a Y o . Aa 10 & ° Y 9 a ¥ . ] A A
Aananuan ¥y Eclipse Niogmiu mlddldauanniofads plug-in lavatewsiiaiie

1 1 ) 2 g 1 2
atlszasAavesms IFnuiuanaeiull FuilugaauvesTisunsuil

’r:llpr.e Platfarm
/ Workbench i Help [New Tool “\

IFace
.

EWT W :

'k New Tool h
; (Team ) *"(
Workspace
( ‘ ’\—[ﬂ\ew Taal -‘]
A N8
.

Platform Runtime. Y
et =/

i

gﬂﬁ 2.6 aoagnssuved Eclipse Platform 8¢ Plug-in

r:uad' dl 1 dyd v Y d'
audutinougnuiaulavesTlsunsutiaenmsaduayuInseaiwues ldsunsun
o LY o a 1
narnuatsuazansariauny 1d ldvateyiiamy HTML, Java, C, JSP, EJB, XML @y
I Y g’l = o Y o 3’,
GIF iHluau nygaumsamivayuanimuadonuniswmun Tsunsunaiuy GUI tag Non-

Y v
GUI wenantudiamnsaldauldnsuuseunlfiians Windows 1ag Linux dnaae

Eclipse Workbench
3 ¥ o v a 1w .
Workbench 1ilunihaenandmsvaaaenugdldauveTisunsy Eclipse 194149

9 . o = A o o =R 2 S Y
AITDA I Wproject LAZNMNTVIUNIDAININIY iﬁﬂﬂﬂﬂﬂﬂiﬂﬁllﬂﬁmjﬂ
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T rr——r—— Nevgate Seorch Project Window Help

= @me W)

& A8 P~ BiF $-0-Q- #E- LS T P .
3 Package Explorer =[] ListViewCustomadagte | 1 i iy G 0 ] T B Yok ot 5 i
= A R R - c-@ElwlxE|DC
Ta 3 .| | @ Connect Mylyn 3
B app.andeoid TestProject g ¢
e = WEML
o f

gﬂﬁ 2.7 Eclipse Workbench

9
Tun199U84 workbench 15zRRUMIBA NSNS Aase Tl
1L AMUUUFAUAAUNYNAN (Main menu) 11AZHDUIAGOIID (Toolbar) Tas@INLAAILIY
. 4 a 4 A4 o ¥ e SR
wyranuazuomnsesloszlaeuniasliielin1sAaas plug-in tin@AY

File Edit Run Source Refactor Navigate Search Prupcl Window Help

CrBE-HEE 88 Z- Bild i $-0-G%- G- ESSF- P SeET evﬁvﬂ:@v;v [ @ oowms [§

gﬂﬁ 2.8 LNHﬂﬁﬂ(Main menu) HAZUALIAI B3/ (Toolbar)cl‘L!Eclipse Workbench

Y H [
2. daupaasiund iU sgnoudie Text Editor #90gasina1s 14d1145y
v ' & = o v . Rayy )
uft luena13a199 FaenasNudaauazun 1Ay Text Editor T IANAGLLU 15U text, XML,

Java program

(I UserFunctionsjava 1] UpdateSQLitejava J) FirstActivity.java X *10 =i

“package app.android.TestProject;

- import java.io.File;

import android.app.Activity;
import android.app.AlertDialog;

import android.content.ActivityNotFoundException;
& import android.content.DialogInterface;

2
38
4
5
6
7

2 import android.content.Intent;

16 import android.net.Uri;

11 import android.os.Bundle;

12 import android.os.Environments

13 import android.view.View;

14 import android.widget.AdapterView;

15 import android.widget.AdapterView.OnTtemClicklistener;
16 import android.widget.Gridview;

7 import android.widget.listAdapter; =

18 import android.widget.Toast;|
19
20 =

| — i 5

‘ﬂﬁ 2.9 Text Editor Gl,chhpse Workbench
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1 Y 1A = 1 . L 1 Aqu 9 A A 1 . <
3. AIUNUINNNYDYIDUS) LTYNIT View mgﬂumuﬂmmmmayjamumu Iﬂﬂlmﬁ% view

vuaastoyauanaranila mu

- Navigator view taadlwanldan Tasazuonvuanyves a3 wu aruiniugu

User Interface 1A @ IUAIUANNIIHINIUVOULD NN AIATY

12 Packagebaploe

el i

TestProject . 5

b B sic
& gen [Generated Java Files]
=4 Android 2.2

» B4 Android Dependencias
fcr assets

& bin

a5 res

b (= drawable-hdpi
b [ drawable-ldpi
p [ drawable-mdpi
b £ drawable-xhdpi
4 = layout
@ firstxml
& gridlayoutxmi
il gridviewxmi
idl Ioginxmi
il mainxml
il profilexml
@‘ registeram|
il reviewlistrow.mi
£l secondaml
i) splashaml
£l thirdaml
b & values

G AndroidManifestaxml

il lintaaml

B proguard-project.bit

B project.properties

& 58 s &i
4 B app.android.TestProject |
p [4] Bookjava
p [J] FirstActivityjava
b [ GridimageThreadloader.jave
b ) GridViewCustomAdapter,jav.
b [ ImageThreadLoaderjava
b [1) ISONParserjava
+ 4] Libraryjava
[ LibraryHelperjava
b i1 LibraryProvider java
p [4) ListViewCustomAdapter.java
p [ LoadlmageView.java
b [@] Loginjava
b ] MyPreferencesjava
> [§] MySplashScreen java
+ [ MysQLiteHelperjsva
[] Profilejava
b 4)] Registerjava
b [ SecondActivityjava
» 1) SQLiteProviderjava
p [ TestProjectActivity.jave
b [3) ThirdActivity java
» [1] UpdateSQLitejava
[1] Userjava
- 1] UserFunctions.java
+ 4] UserHelperjava
[1] UserProvider.java
[ :5 gen [Generated Java Files] -

L s ' s—

d‘ & . 0 = 1 S 1 %
E‘IJ‘VI 2.10 Navigator view UYDNEclipse Workbench Fautasznnveslvdedrestanu

1 v 1
LogCat view LaAIAIWAANT 130 Error A14 9

| Problems | & irvades |16 Declaration| @ Comole FloaCaticl o =0
SavedFiners o o W | Sawch o messane. Accests lava tegenes, Profc with i ape, g o 1 6 it scope. 1 T |verbese, =] W R[ED &
All messages (na fiters) (10 " o 2 1 T -
| appimrdroid TestPucject (5 | L5 il 0TI Application L Lo T
] OF=10 15:08:3... 137 EeL) e
08=10 15:11:4.. . m e
-14° 187412 122
o OB-10 1114, 3 a2 App.andzcid. Tes aalviiem
oR=10 18:11:d.. 137 app.androld TessF...  glokal

gﬂﬁ 2.11 LogCat viewUd Eclipse Workbench
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. . 1 a’d‘d
- Outline view mea’;umm‘lvdamuﬂﬁuﬁ"lm

=M

8= Outline 22

P EER W e w"
B app.andn.:-i-d_.'.l'es‘thJect -
import declarations
java.io.File =
android.app.Activity
android.app.AlertDialog
android.content.ActivityNotFoundEsx:
- android.content.Dialoginterface
< android.contentIntent
android.net.Uri
“— android.os.Bundle
< android.os.Environment

andrnicl srigmss Viess:

7] — " J »

gﬂﬁ 2.12 Outline view84 Eclipse Workbench

2.1.3.3 Android SDK (Android Software Development Kit)
A dl [ dl 1 Y o [ a o A
Aoy l1sunsuNNIe Google Wmuoonuuionani el diniauennansunse
o o 1 1 1
Aerulana lanniiTvaaldlas liiden1ldi1e Tuya SDK azilsznoudie
- Android Virtual Device (AVD) %39 Android Emulator
A A A S A A S v A s o
foinsesiiotiansginsaiiiononieo Tablet NN IzIIAdouMOUgNTBI NI
A oa s a VY o 0 a 4 A 9 Y
szupliiams wouasesn 139 Rianawsnihuennamdunasnmaacsla
- Android Platform
1 1 ' o o o a ?J
flo Android OS ti@az3u ¥9g 19deeHn15a1211 Tnaaa191NAAAY Emulatoris o130y

a7 1o 1% Emulator 1315083514 Platform 17349 1@ 193 Android 2.3, Android 3.0, Android 4.0

Ty st S0 Maanages i : e i
|| Pockages Toots 3 _|
ST Pathe’ C\echipaeandimid-sdk-mind
| Packager
W Mame APL Ree  Smtus
- Took
X Andeoid SDK Took 16
10
:
15 |

Obsolete Ssip e/ Updas Bratail § packsges.

[ =]
Done leading packages l

gﬂﬁ 2.13 11¥1A19909 Android SDK Manager
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2.1.3.4 ADT (Android Development Tool)
) @ . 2 g 1 = { o .
Ao Plugins @151 Eclipse Fuiluaruaiunlylunms@ouldsunsy vi11d Eclipse
590 Android TaegnoenuuumnlvtiniinlumsdsvanimmadouvesTdsunsy Eclipse il
A a a 9 a ) a oA 4
mivdszansamves Tdsunsulumsadraenndmduuszuvlfianmsuouasosa lag
g1ueANNdzaIn TRRWAIE11508519 Android project 143, User Interface, IWiipackages

Y ]
VUNUFIUUDI Android Framework API, debug towwatntsulaeld Android SDK tools tag

1 <3
ad1alWldluy signed 13 Bunsigned UINEANA .APK lapd 19320152

3 % Q'J LY/ d
2.1.4 mnialFlumsWannuennwamduuuszuul fiiamsueuasosn

2.1.4.1 /M¥19191 (Java programming language)
AN 181 115UNTUIFIIAY(OOP :Object-Oriented Programming) Ngnnau11ag James
. a A A o . = I | &
Gosling 1a23AIn5AUBU IUUSHN Sun Microsystems 11 w.¢. 2534 Taailuaiunilavos
2 { o s P A
TA54M13 The Green Project Fuiulasimsndesmnaurszuuserdursienruau
4 < 5 ' s

o ld Idhamadnmelutn vazdudveengaisismz ull wa. 2538 Taeligailszaan

o A 9 1A dyd 1 [9) = go A 9 ) Y
Tumswa e ldununiy C++ uaumMeItizon110 181 10n(0ak) FIasFen1wau lonlna
{ o v A a a £ { 4 : I 4
91U YeIJames Gosling teitiipsanlyminisdavanssudlasu 11 1¥¥e "9 Failuie
voanuunu

9 K X g
ﬂi]i]'i.l‘l«!lﬂ@ﬁi'luallﬂﬂﬂTH1%131@!,&51Iﬂf] Java Community Process %\‘llﬂﬂﬂig'ﬂ?uﬂ”ﬁ

Y ¥

' 3 A Y 1 ° 4 9y
pgnuilumamsfeyana lddnauludsmdmuaanuamnsaluamunaanosyla

[ J

2.14 dYanyaived Java

SaN
=iy
=h.
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2.1.4.2 XML (Extensive Markup Language)
Aemn 19 M5 unsWeuenans markup (markup document) 1ae3in15 19 metadata
A A Y A P} ' ' A A
(1130 tags) tWRUBNYMTNNAz Y szNURITOYA TUAIUAIIVOUDNATT NITINY metadata (W3 D
Y

tags) 11111/ Tweneasauisaili lassadvvevenasdanuiunazsinlyinsyseulana

I 1 1o & { @ S A
nansitiu'llTasdreuag hisuilufzdesordonyudimednnuendls

I ~ Y] A Y 1 A 1 a s A W Y

XML dlummiiimunznumsuanilasudeyarunioisaoniuaes tiognin ila
42' [EY) d A a oa g’; v 3 A A 1 A 9
Yuegnulsunsuilszgnanieszunlfiamsla neduilunentianudangu iesang 14

A o g‘.} 1 A Y o A 9y 9
AU130NVTIHMUALAZAIAT metadata (W30 tags) IHIMINZAVBAAITIRNIZNAUADINT 1A

] a o A a A Y [ 1 1
98190 a5% UAZHITINITOLNUIAL metadata (W30 tags) o lunievadlaglilinansznuae
{ ] L) o 3 1 % .
Tsunsuifiogudidae uonviniu XML §adeiludaunilaues SGML (Standard Generalized
= g Y o 9 A o o ad A oA
Markup Language) SafJudamvualunmsainanssdanuendrs lugluuvdiannseiindngn
o Jd i 3 i A
fmuaTagedfns W3C (World Wide Web Consortium) Iaalnssddtwuazjiluuuiniald
a o = Y Y= o 9 o 9 A A 9y
ponnansua1eg awsaizen ld1dauld 3eihldmstansdeyanieisenlddoyanin
' 9

LOWNAAFUAN UUOG TUNINIFIUABINY  Tag XML UMIMUUANYUAZIIoazIDIAT0

Herena1snizeni1 DTD (Document Type Definition) 48 XML Schema

<?xml version="1.8" encoding="UTF-8"?>
<IDOCTYPE note SYSTEM "note.dtd">

<note>

<to>Tove</to>

<from>Jani</from>
reading>Reminder</heading>

>Don't forget me this weekend!</body>

oter

(W, [ S ¥ RS

01~ O
[

a o ~
qﬁli]TI 2.15 AI091NUDINITIVYU XML

2.1.4.2 JSON (JavaScript Object Notation)

A o Y] o o = ] A S A 1 ]
Aovlesuunvesdoyadimivuanilasudoyanouiunes Neglugidoniusisuan
A Y 7 A s ) ¥ o & %
(plain text) NNwywduaz Tlsunsunouianeiamsaoudlala neduilulionsains
[ 1 § 1 2 [y J 1
Sudetonnui luduegiuunanosu(independent Platform) #u18AINNNANTEIAINITO

¥ oL A ) Ve oY
1% Thensain lumsuanasudonnuszninanu'lé
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TSTreetAddress”: 21 Znd 5Treet’,
"city": "New York",
= “state®™: “NY",

"postalCode™: 18821

I

"phoneNumbers™: [
11 "212 555-1234",
12 "646 555-4567"

‘ljﬁ 2.16 $20619Y9INTIVEY JSON

A o ' = @ 1 <] < o Y1 12 o Y1
JSON HanyULIBUIAYINUXML UalvUIALan 137 uazmuuﬂ”lmwmw i]\‘i‘l/lﬂﬁ’fﬂu

I~ [ g‘a o 4 o ]
uaz@ou 14159071 usnaIniu JSON datianuaiusolumsldeisisdnunsiednae

1 <presonlist>

2 <person>

3 <firstName>lonh</firstName>

4 <lastName>Smith</lastName>

5 <address>»

B <streetAddress>21 2nd Street</streetAddress>
7 <city>New York</city>

8 <state>NY</state>

9 <postalCode>10021</postalCode>

1@ </address>

11 <phoneNumbers>212 555-1234,646 555-4567</phoneNumbers>
12 </person>

13 </personlist>

ﬂﬁ 2.17 mamwanmuammmr}u LL@]’E]ﬂL"’llEIH@]’JEJﬂ']‘]eI"I XML

2.2 malulagmmsumsdansvoya

2.2.1 insesdefFlumsdamsdoya

2.2.1.1 SQLite

v

Aogrudoyaytanilailigauauianesmsauuana19InszUuTamMsgIudoyas

q

[ @

J . I Y 3 Ay Yo
TUNUTD (Relational Database Management System) meﬂugmmayammmamq'lmumm
A ' o . < o ' a <
HIUBDYIUIN Iﬂﬂgﬂuﬂﬂﬂ1i‘ﬂ1ﬂuﬂlﬁ]\1 SQLite lf]J‘L!LL‘LI‘]J Standalone V]WQWH?JQGI,HLL@‘WW’QLWHH
¥ a Yy A v & A ] = il 2 ¥ oa <
HUA LLﬁgiJIﬂﬁ\‘lﬁiN‘ﬂ\?18@]’0ﬂ15%ﬂ!ﬂ‘ﬂ1’i56u11ﬂ1% szﬂq"lvxlammﬂuuummmmaﬂmn

A 1w <3 9 Aa K o Aa d A o 4 ' <
MNaUNMNUNMITLINUUDYAVIN Nmmxﬂmt’a‘v\lwmﬂ"]m“l/l“I/]NTL!‘]J“LJ’cﬁJﬁ‘V]I‘V\Iuﬂimman@]Lﬂu
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i1 Ed
9819110 1119991 V0 IAANIIMU Hardware {18 Memory FIUNIANNE N0 TUNIT Process

A o

1 4 V2 o =
Foyaaeuuamsn iy Taoguauiiauaznsiiauves SQLite IAall

4 [ [ g}/
1. wo5alanueasQLite gniimulugiuuuvedLibrary@1en111 C fariums g
1 a ?{, 4 1 o 4 1 % 14
SQLite 33 lidosfnnalilsunsulanaslumnieaServer uavziiwosa lnasQLite Ae3runusos
9 a J A o dS! Y
alanveaennamFunianyu ldae
. < 9 Jd A A ~ 1 . Y 9 @
2. SQLite inuYoyaaslulWdiies Iidfeniion 11 Database File” doyaszgniiise
f A 2 o = s I A o P} o wn
Aaunvznuuinaslu lrldiazooasianeunzainnldnusan Tuia
3. Uafmdavedn1y SQL Tiawsaldanlu sQLite 18 191 GRANT 1agREVOKE
A . < s v Y ¥ ! A A g ¥ .
11199910 SQLite Nudoyaaslu’lva dsiuduasun1se unIolouiuzaoIHIUNS
a £ 10 & o v ' g
asaoUansmsIFauuds 39 luiludeslgmaanaiil
1 A I~ a I~ v
4. 8QLite 3¢ luaulsriiavestoya laed 1daunsanudoyariialan laaslunoduil

a

A I < shé 1 o Y a a
nistatlue lan lade luv lnaanuranaia

Y
v o
1en1NH SQLite §413J4 Open Source aenunsaladnn1ans uazdaaunsaly sQLite
U Platform 9199 1A%a1832 001 {11AN151%U Windows, Linux, Mac, Unix, iOS 1182 Android
o L " A A
Tagansou ldszgndldau ldnarnvate wuanduuis, llsunsuuuugeuniy wagms

) Ay 1 g Y S A A A
!ﬂ‘UGUf]ilaﬂﬂ@\iﬂ1ﬁﬁ\1lﬂullwamﬂuﬁﬂ’]\iluaﬁiﬂuﬁﬂﬂ

%the

51 2.18 dydnwaivessQLite

2.2.1.2 MySQL

A o 9 A 9 Ad Y g v o &
ﬂﬂiﬂil!ﬂilliigUUﬁ]ﬂﬂﬁ;ﬁpu‘Ui’)yja 3J1’i1‘l11’llﬂ1J"1J’E)3J”a’E)EJNL1Ju‘§$‘]J1J FONTUANTINTIY
I A A o o =<} 9 A Y 9 ) 2 A A
SQL(Structured Query Language) L‘]Julﬂiﬁ]ﬂll@iffﬂ’i‘i“]JLﬂ“]J"lIE]lIaTW]EN PFIIUNUIATOINUDYITO

U

Tilsunsuduedysanmsie 149 1aszuuauisessunudensvesd 14 uhausuny

d‘ Y a 1 a rfd' o y di a . . 1

Web Server 110 1 UTMsunmansdaniiaudaunioausn1s(Server-Side Script) (U D111
< 9 A o ' % 14 . . '

PHP, ASP, ISP 1iluau viseinausaunuTlsunsuilszgna(Application Program) 154 2111

I Y
Java, C 1luau
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S v . o A o
uona iU MySQL duiluszuugiudeyanuOpen Source FagniimulasusEm

9
MySQL AB lutlszmaaimu Taelinauunlild laeg ludear ldaenaznunsagsne

2.2.1.3 SQLite Database Browser
A
SQLite Database Browser aeozls
A ) v W v 9 . A o
Ao Tsunsudmsudansnug uToyasSQLite 1V freeware NAIMITDAI IHAANT
1 1 1 I {1 o [ 1 3 4
1% 18 1ae ludear 19918 Wuldsunsungelimsmhaunugudeyadiotu Tasligailszasn

wanaems WE 19a319, eanuu, ud lvgrudeya tazduideya’ld TaslidesldmassqL

nrnmallsunsu SQLite Database Browser

TaJ51n53 SQLite Database browser gnoonuun 1Nz UDWAWDY spreadsheet

& SQlite Database Browser - C/Users/user/Deskiop/AppDE.db

File Edit View Help
i =] e a4 S odF | o | ey I
(SR = Rl -l e e RET A
i
Database Stucturs | Browse Data | Bxecute SOL |
Table
BookiD Book Tils Type Description mage PDFAddress Pric
1 1/ android1 1| detail of android1 | android 1 png bomb pdf
2 2| android2 2| detai of android2 | android2ng DIP pf
3 3 android3 1| detl of an3 android3 prg Cpd
4 4 androidd 1/ android andraidd pg chDt pdf
i
[ L3
I
1-40f4 [ Gote: 0

U 2.20 wihenaldsunsy SQLite Database Browser

SaN
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2
vumihaves lsunsulseneudieaunangaane 1

1. dIUUUFANAA Menu 148 Toolbar 57131A504N 14 lunstamsnugiudeya

FUMIAS, a1 HIaLA a1 19 aausain 1a lagludeldmdasQL

File Edit View Help

Do a2y o B

gﬂﬁ 2.21 Menu iag Toolbar U9 SQLite Database browser

2. 1111614 Database Structure §115UMFIAM NN TATIAT19V0I7 MY 010

= _ ____ fsbie CREATE TABLE Bock/BoukiD riege primary key mesrcre—wert B0
i Dowriosd table CREATE TABLE Dewmicad(DL 1< rteger pemary key sutoncremen
i Member natle CREATE TABLE MasberiListmans et pamary key Frtnans tag n
i Type able CREATE TABLE Type{id intager pamary key soncrmant. Type n.
i androd_metndsts table CAEATE TABLE sndwad_metadats focsis TEXT)

it solte_sequence bl CREATE TABLE sclee_sequenceiname seq)

gﬂﬁ 2.22 W94 Database Structure V84 SQLite Database browser

3. 111189 Browse Data dm5umsdamsdeyalunaazaisig

Daiabase Structurs | Browse Data | Fxsoute SQL

Tob: [~
BooklID BookTitle Type Description Image PDFAddress Prict

1 1 android1 1 detail of android 1 andreid 1.png bomb pdf

2 2 android2 2 detail of android2 | android2 png DIP pdf

3 3 android3 1 detil of an3 android3 prig Cpdf

4 4 andridd 1 android androidd prg ch1 pef

gﬂﬁ 2.23 11019 Browse Data U994 SQLite Database browser
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4.v711A19 Execute SQL dmsudamsnugiudoyalaoldmiaa SQL 15U CREATE,

SELECT

Database Sucte | Browsa Data | Execute SGL

SOl sinng:

SELECT Type from bookc

\Ematngumey
Emer message from database engine:
No emor

[hata retumed

§1Jﬁ 2.24 %1919 Execute SQL 494 SQLite Database browser

222 mnilglumsdamsgiudoeya

SQL (Structured Query Language)

A 9 A @ 9 1 = 9 2 & ~Aq Y

AommaeunmdoyansonuIaMIvoyand1el Inseding suiluaminldlums
= A o @ 9 v 9
@euTlsunsumedamsnugiudoyalasmwiz tazduilunemasguuuszuugiudoya
A o v J I a o o @ A <3
Faduiusuaziluszuila (open system) ldaunsalddide SQL nugmdoyawiialan

9 o w = @ A < 1 9 ~ 1 v a 9 v J A Y]
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Select a site or enter the location of a site.
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5.1 Tada 141} Window->Preference

Fée Edt Runm Navgee Sewch Prowct Refactor
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1 Package Explorm 1 =

519 n.15 1Y Window->Preference
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Ant SDK Location:  C:\Users\usef\android-sdis | =
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Android
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Help
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Android

Android Preferences

okt el g (
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Target Name

Vendor Platform  APIL..
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6. VUADUMIAANI Android Platform Naz1¥lumsnannuannaniu

6.1 1l 1Y Window Lag 180N Android SDK Manager

6.2 1a®n packages NVTWAIU1 WEOUA Tools 1Az Latest USB Driver Version #1151M5AAAD

) A A A a Y A
NULATOINDDDITIC LkadladNInstall

[ i3 Androd SON Platiarm tesks
# [B 5 Andieid 41 (M1 16)

M SDE Fiatfm
191 &y Eompies for S0

W g Google APl

¥ [ Seurees for Andmif SOK

5 Andredd 403 (AF118)

L Android 40 (APL L

2 Andreid 3.2 (APT13)

21 fndveis 11 (ABTLE)

41 Andreid 10 {APY 1Y)
Andrmid 213 1ABE 1

Shows [ Updatealem |4 bnataied

S by @ APLIevel Fepostoey

Dienet loading packages.

ap

[# 55 Documertation for Andvaid SDE 15

I % ARM LADI v7o System image i

Obsoicte Select Haw or Upsite | Instal § packages...
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]
-
4

(s
-
X
b

Deiete 2 packages..

M99 Android SDK Manager



6.3 1d®NAccept AlllidIna Install

Packages

Package Description & License

 Android SDK Tools, revision 19 3
 Android SDK Platform-tools, revision L. %ﬁmkage sk S Tl
 Documentation for Android SDK, APIL... - Android SDK Platform-tools, revision 11

~ SDK Platform Android 4.0.3, API15, revi..,

] »

= Archive Description
“ Samples for SDK API15, revision 2 (| e Wm e
* ARM EAEIv7a System Image, Android ... Size: 356 Mi
~ Intel 86 Atom System Image, Andreid ... SHAL: Bmlsldﬂeedmsdldﬂlhmﬂdcb:

~* Google APTs, Android API15, revision 2
» HTC OpenSense SDK, Android API15, r...
~ 1C5_R1, Android API15, revision1

s Coviecos for Aecdenid COV_ANIIS coic ) Accept (0 Reject

Site
Android Repository (dl-ssl.google.com)

n

® AcceptAll

sU7 n.19 1@onAccept All

a Z <3 2
6.4 38 T1sunIuAAAIIUIETY 11T Alert dialog VUM 1¥1ABA OK #50 Close

mwﬁmwmmm 15, revision 1

be updated.

The Android SDK and AVD Manager that you are currently using has been updated. It
is recommended that you now close the manager window and re-open it. If you use
Eclipse, please run Help > Check for Updates to see if the Andreid plug-in needs to

AT T ~ — — - — J
Show: [ 7] Updates/New [| Obsolete Select New or Updates [ lnstal 11 packages..
Sort by: @ APl level *) Repository All |_—D:!m 1 puhgi

e —————— y

Downloading IC5_R1, Android API 15, revision 1

31l n.20 soTUsunsuRnseuLas e

7. YUABUMSI5H Android Emulator

7.1 Wa AVD Manager Tae'lJN Window-> AVD Manager LAADN New. ..
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7.2 52AMANLAVD Android Emulator Tngnsondletoyasane liil

Name: f1ua¥e 1990 1UEmulator 11 AVD2.1
Target:1A9NTLAUUBIAPIA M platformNABINMIWAIUT 191 Android 2.1-API Level7
SD Card: Size: 1024 MiB

Mmae: 19A1 Default

1&2Aa0N Create AVD

tald -0 -q il

Name:

CPU/ABE | ARM (armeabi)

—
£ Android Virtual Device

D Card: : =
[ © Sz 1024 MiB v Lo |
Sl B ¢ 0 | [Browse... =
L (e
7] Enabled [R""'" |
[ Deta
® Buitin:  [Defaukt (WVGABDD) =] (5 N
Resclution: !

Property
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~ Avalid Android Virtual D I
| X MMWDM

CreateAVD | [ concel |

2 g9 i W 5 S 9 qua Y
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A Y

EJ
EmulatorMNHNUANYNAITN



‘Andvo' —

List of existing Android Virtual Devices located at C:\Users\user\.android\avd

AVD Name Target Name Platform API Level CPU/ABI

[ AVD21 Android 2.1 21 7 ARM (armeabi)

i

il ~ Avalid Android Virtual Device. | 1| A repairable Android Virtual Devit
X An Android Virtual Device that failed to load. Click ‘Details' to see the error.

gﬂﬁ 122 MI1A19Y8Y AVD Manager

7.4 ¥1M35U Emulator 1Agia9n Start 11411290 Launch

v Awalid Android Vitual Device. [ A repairable Android Virtual Device.

X An Android Virtual Device that failed to load. Click ‘Details’ to see the error.

519 1.23 735U Emulator

u

7.5 Emulator 325 UM 19149108191
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'. Preparing SD card

Al
(4 U v

8. TuAaUM 3 Sign and deploy HOWHAATHNNARNMANTSD
A : Ay o 3 .
8.111a Project VI@]ENﬂﬁ‘I/ﬂﬂ’Iiexport"lmﬂJﬂu Eclipse

8.2 AANUIN ﬁ‘%@project 149n Android Tools > Export signed application package

[ New -['0"\.' CRCRS - 1 A
?’JI Golmo 1) Updstesquitegava | 1) Fustactiyjava £
T o it \andeoid.TestPragect;

Open Type Hiessechy H pdo.rile;
Shewln ARaShita W b
i o Ciieg  J5 Flrstactivity extends activity [
| Copy Qualfied Marme
o Pame i | B
4 % Delmte Dot string pfy
Femewye hom C =
e J: I‘I id 4 v Bund]l: ved 1 #Stat
s Aonshigy [ o encreste(hundle sondinstancestat
Refctor AleShifteT s
duta-generated sethod stb
‘-».. e
ud Bpet beboe |12, Declomstoom | B Console 2 X0 LogCat]
N ety . T Mo Tt Projest.-
Close Project G Mot e
Close Unrelated Projects.
oo Wiarking s tport Sagned Application Package...
M:‘ | oo nsoned Application Pactage.
Oebug A o1 Doy e bsecede
ik | Renarme Applecation Packagr
Toaen o Add Support Libeiry
Comgare With y|  FebremcPopete
Restire from Lacal Histeey.o 1 Tun Link Check fer Commen Errs
Andreid Tecks ' it Lint Markess
Conficpre. .
b Propenties e

gﬂﬁ 1.27 1800 Export signed application package
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8.3 A32980UNTOprojectdNADI 11AUADN Next

| & Export Android Application

|| Project Checks

Performs a set of checks to make sure the application can be exported.

Select the project to export

Project: TestProject] Browse..,
No errors found. Click MNext.

@ [ <8ak Nea> J[ Fnsh [ cance ]

[

9
8.4 Keystore Selection 22l 2 Auden Al

- Use Existing Keystore lunsaling Export an

- Create New Keystore 114n5ai#1 11iin8 Export 115984158514 Keystore 1113

[

AR o o A Y = A o v A < 7
“lu‘wu@ ANUADN create new keystore LUAINAN browse LaﬂﬂmLM’LN“Vl%m‘U"lWa keystore
Y

Y
U

Y A L )
W‘i?)ll‘l/Nm‘h’E]"Ma HAINIHUA password
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|| Keystore selection

() Use existing keystore
@ Create new keystore

Location: C:\Users\

: Password: eeesss

| Confirm: essses|

gﬂﬁ 1.29 WA Keystore Selection

[ 1 I 1 { o o [ [
8.5 laswazideaueanisaiig key lasdmvussiluaiuindrnadesla daudiuais (dhald

] 1 L~ o o a o
i) azlawse lildnld Tagludeiiuave android market 9zAo v 1RBNNARITUTID Y

9
v @

Validity (years) 941 2033 39azrnunaa el lila lvarea wu 1003

Password:  essess
Canfirm: Fassess - :
Validity (years): 100

First and Last Mame:  Matnan Smitthimedhin
Orgenizational Unit:

Qrganization:

City or Locality:

State or Province:

Country Code (X):

(:?jl < Back [ Mest > ] Finish Cancel

51U n.30 ldneaziBeavesnsaing key



o o 1 o v I J g A .. A 2 2
8.6 ﬂ'lﬂuﬂ@nuﬂuﬂﬁ'lﬂSi_ll,ﬂlllh‘lﬁ.apk NUULADN Finish INDIFTITUVUADU

|2 Export Andeoid fople st
|| Destination and key/certificate checks

Destination APK file: C:\Usem\LMDuhop\‘fcsthj:n.apk Browse...

Certificate expires in 100 years,

3 o o ' o v a
s 031 nuadumisdmsun T apk

9. YUABDUMIANAT SQLite Database Browser
o v A g‘;
9.1 A1 11aAAIAAAIIIN http://sourceforge.net/projects/sqlitebrowser/

o = a Y Y Yo A
9.2 ﬂﬂluaﬂaﬂ]lﬂﬂaulla’Jﬁ']jJ']iﬂ‘l"]f\ﬂu]lﬂ UN

File Ede View Help
| ) — e — —_— —_—
D@ e e o ofl @ |7
|Bomom S [ e Bts | ot 358 3
oo I (@] i Racord | Dot Rocond |
k0 ook T Tiee fss— [ POFAddmes
1 I_‘ﬁ;d;l 1 delod of w‘ M“ m_ﬂ
[z I S 2oedmdost ety UPed
|2 3 1 detl of a3 wdudlpg  |Cod |
'r | andodd 1 et i png chill o ‘ |
I | |.4.u- [T (]

sUf n.32 wihaaTisunsy SQLite Database Browser
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10. YUADUMIAAAIAppServ
g < 4
10.1 @121 1raalUsunsu AppServ 910130 1@ http:/www.appservnetwork.com

Y Y 1 ¥
10.2 suiiianan lonouAAAs Appserv tiloaansya 11sunsu

appserv-win32-2,
6.0 |

31 n.33 onoUARRT Appsery

' Y
10.3 Gudgmsanaa Triaen Next

Welcome to the AppServ 2.6.0
Selup Wizard

This wizard wil guide you through the installation of AppServ
2.6.0,

Ttis recommended that you dose al other applications
before starting Setup. This will make it possible to update
relevant system filas without having to reboot your
computer,

Click Next to continue.

o, appse rvnetwork, col

Mext > ] Cancel

v Y
51N n.34 1hgmsdaas

FJ
c%

104 1iguuaouideu lunisldauTlsunsy TasTisunsuappServ lauanarelugiuny
. o A Yy a A o A 1 1 [] o A Y
GNU License ¥ingouiuiou lvlinansudulasdon 1 Agree tan1ni lusensuiten v 14

A A a gl.l
1890 Cancel LWE)’E]’E]ﬂ%'IﬂﬂWiG]ﬂGNI‘]JiLLﬂilI
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License Agreement
Please review the license terms before installing AppServ 2.6.0.

Press Page Down to see the rest of the agreement.

GMNU LESSER GENERAL PUBLIC LICENSE -
Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc.

59 Temple Flace, Suite 330, Boston, MA 02111-1307 USA
Everyone i permitted to copy and destribute verbatim copies
of this icense document, but changing it is not allowed,

[This is the first released version of the Lesser GPL, It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.] -

1f you accept the terms of the agreement, dick 1 Agree to continue. You must accept the
agreement to install AppSery 2.6.0.

(lseex || 1agee | [ cone |

g‘ljﬁ 1.35 License Agreement

¥
%

{ N 1A {a I
10.5 aentarenenasimsdads Tasamisududatsniaiaansazitluc\AppServ 110

= v ¥ A

) = A & v Y A dl
apan1stlasuilarenianaaad 19naBrowse HANADNUA1EN19INABINT 1NUUIADA Next

A A g 2
Wworaendatgmaasoau

Choose Install Location
Choose the folder in which to install AppServ 2.5.0.

Setup willinstall AppSery 2.6.0 in the following folder, To install in a different folder, didc
Browse and select another folder. Chok Next to continue.

Destration Folder

C:\AppServ  Bowse.. |

Space required: 77.5M8
Space available: 71.5G8

I<m||um,][c;md]

i H 9
510 n.36 1@emlarenaiidesnisanns

v &

] 3 )
10.6 1800 Package Components N194n13AAAY Tasasuduiuag1iaonainn Package 1a

"y A < A Y A9 a '
HINNADINITLADNAIURNIZ U Package NATNITDADNATNUDINADINITODN Iﬂﬂ§1ﬂa$l@ﬂﬁl!ﬂ

A o

Y
¢ Package Y
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- Apache HTTP Server miuilu Web Server

- MySQL Database Wiy Database Server

- PHP Hypertext Preprocessor ¥#1111/5217anan1391914v990181 PHP
. P a o Y 1 < J

- phpMyAdmin 1% 1unsuinissamsgiudoya MySQL w1y lad

A A a v Y Y A
IWONINISLaeN Package 1381TDELAT Glmam Next

Select Components
Select the components you want to install, dear the components
you do not want to install.

[V Apache HTTP Server
[¥MysqL Database

[¥] PHP Hypertext Preprocessor
7| phpMyAdmin

[ <esk [ memts ] [Lconcel]

9
[ (2

10.7 MYUAMABUNNVOI Apache Web Server UNarua 3 U St

- Server Name f?wﬁ%uﬂau%’ay,a%a Web Server 13U www.appservnetwork.com

- Admin Email dnSuiloudoya wardquaszuy 15U root@appservnetwork.com

- HTTP Port dm3uszy Port fasi3enlda1 Apache Web Server Taeitaluuda

Protocol HTTP asfimmnanaie 80 Windeamswaniaean1sd Port 80 fiaunsoud lv'ld

winfimsifdeundas Port 1511991 Web  Server 121 nnasadiizenlFindylad
Tufludesszynuiomy Port 20 130 vianiden1¥ Port 99 °1uﬂ1m9ﬁﬁu“lmﬁnﬂﬂ§”qﬁ’aﬂ%
http://www.appservnetwork.com:99 Jzannsonlgaula

A ] Y Y q YA
!3JE]ﬂi’é)ﬂ"l]@ﬂ;lﬁﬂiﬂi‘l’)‘lll!,m?clﬁm@ﬂNext
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& Appsery 2

Apache HTTP Server Information

Please enter vour server's information.

Server Name (e.g. www.appservnetwork.com)

localhost

Administrator's Email Address (e.g. webmaster @gmail.com)
‘ admin@localhost.com|

Apache HTTP Port (Default : 80)
80

| Lok || next> | [ conce

9
v % 1 %

F4
10.8 fviuamAsUn e MySQL Database Ho8f 18 UNIHUA 3 I A1l

U

Root Password dmsutlou sWarumsdldaugiudoyaves Root niohguaszuy

a9 U

A vqu 9 o A 9 ) A
’Vjﬂﬂi\i‘I/I!,"ll'lsl,“lf\ﬂl@"lu"llﬂll“ﬁqluaﬂ‘]elil‘l%ﬂ!,ﬂu%@uﬁﬁgﬂﬂ Gl‘ﬁﬁ%‘U user A9 root

E]

o o o 1 ! v & o w
Character Sets @iuiuamszuunn g lumsdanugiudeya, Sosdny
Y 9 Y a 1 9
F1UvYa, Import JAIUVBYA, Export JIUVDYA, ANADITUTVDYA
) IS - @ 9 @ J o [
Old Password mmu@’nuﬁmmmmmmﬂmm PHP N1 MySQL API 1I93%ULNN
Ta819® “Error Client does not support authentication protocol requested by server;
. 3 . Y A ' A A A
consider upgrading MySQL client” T¥iaonluaiuves Old Password IWoHiaNIaYd
Y
vl

v ) 9 ) =
- Enable TnnoDB 11nA09ms I5a1ugiudoyalugiuuy nnoDB Ididendiuiidie
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‘ m MySQL Server Configuration
Configure the MySQL Server instance.
Mysou

Please enter Root password for MySQL Server.
Enter root password
LAL L
Re-enter root password

MySQL Server Setting
Character Sets and Collations
[UTF-8 Unicode -

(V] Old Password Support (PHP MySQL API function.)
[”] Enable InnoDB

[ <pak || poat | [ concel |

g 5 2 A A v v
10.9 szUUa0AN15I9U 1USUATHIZUAAIYULT @8N Allow access LW@ﬂiglﬂluWIGlﬁigiJ‘]Jal‘H

Appserv"lf?]’

Y
10.10T1/50n3umMariimMsaaas Trldda o

Nullsaft Install System v2.18

<Back || Next> | [ Conce

' 9
suii n.40  TasunsuAppServ Matiimsnaas

Y
=1

Y 9 9 9
10.11 Fugavuaeumsanas 1sunsy AppServ dmsuiunougameiivziliidoniidesnis

< PE o v oA A ' ES ' L. A 3 £ a ¥
ﬁ\iiﬂﬂﬂ’liiu Apache 1ag MySQL T]uﬂﬂﬁ@]lﬂ “’l]’]ﬂuuﬂﬂﬂll Finish INOLETITUNITAAN
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Completing the AppServ 2.6.0 Setup
Wizard

AppServ 2,6.0 has been installed on your computer,
Click Finish to dose this wizard.

Yoora

V] Start Apache

(/] Start MySQL

COMPUTE

i o8)
www . appservnetwork.con

9
£

Y 9
.41 ﬁugmumummﬂmiﬂmﬂin AppServ

=D.

el

9 ) s Y A o '
10.12 naaoa 15911 AppServ Iaaitla Tdsunsuus1ugesuaMun URL Tusoq Address

http://127.0.0.1 Svinidla'lduaasin Appserv enansalgaulauds

The AppServ Open Project - 2.6.0 for Windows

5! phpMyAdmin Database Manager Version 2.10.3
A PHP Information Yerson 6.0,0-dev

Alowd AppSer Varsion 260 o
AppSens s & monging 0pon $ource softwarg instelier peckage for Windows ncldes

o Apache Wirb Servor Virion 2 2 8

» PHP Seript Lenguage Veron 6.0.0-dew

» MySOL Dotabase Yerson 6.0.4-alpho

» phpMyAdmin Dolnbase Manager Vession 2.10.3

» Changelog

= README

« AUTHORS

= COPYING

» Official Site : i/ fwsw AppSantitwork com

+ Hosting suppor by - hilp /wwe AppSentosting com

Change Lanquage : === ey
* Easy way to bulld Webserver, Database Server with AppServ :-)

W3 http://127.0.0.1

CaN
=iy
=h.
2
'S
N
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Mmsa313911st9n Android 11 Eclipse

1. 18007 File > New > Project > Andrild project 1AADN Next

Eﬂﬁ n.43 M3a319 Andrild project

2. mnuave Til53ave Eclipse taz laisaneinaz 14 lumssafiu lvdvea T nida

Create Android Project

Select project name and type of project

Project Name: HelloAndroid

@ Create new project in workspace
Create project from easting source
Create project from existing sample

#|Use default location

[ C\Android ',‘.'r:rk(p:(e\H\"IcA—ui.'tld_
Working sets
7] Add project to working sets
Working sets; |




93

3. 189N Build Target A9 Version U84 AndroidN@eam s 19%11un15 compiled AULBUNAIATY

Select Build Target
Choose an SDK to target

Build Target
Target Name Vendor Platform  API.. |
[¥] Android 21 Android Open Source Project 21 7
"] Google APls Google Inc. 21 7
7] Android 403 Android Open Source Project 403 15
|| Google APIs Google Inc. 403 15
| HTC OpenSense 5. HTC 403 15

I
'afl n o

Standard Android platform 4.0.3

317 n.45 180N Build Target

4. MYUA

4 a ) { 4
- Fevowonwansunzlsing luginsal Android

= E) v &

4 4 J o { 1 3 1
- %004 Package Ao ¥oved IWamas N mINdany Class aee I3 viiluwnuiany
LI A o A @ A 9 & a g = I
- Create Activity A8NITNIHUABDEA1NTUY class stub Mazadrelaslanouil ¥y
subclass U4 Android’s Activity class

1 U 'O { o d o g a (;I
- Min SDK Version ADA1 API sgaumganIulud s utennan ¥y

Q

&8N Finish



Application Info
Configure the new Android Project

Application Name: HelloAndroid
Package Name: com.android.HelloAndroid

[¥] Create Activity: ~ HelloAndroidActivity )
Minimum SDK: 7 (Android 2.1) -

[7] Create a Test Project
T N HelloAndroidTest
HelloAndroidTest

com.android.HelloAndroid.test

gﬂﬁ N.46 NMUUA Application Info
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a [ 4
HETNANN

1. mﬂﬂ‘mniu@ﬁﬂq (OOP = Object-Oriented Programming)
= { 1 [ 1 o [~ 1
Aomaveu Tlsunsunlszneudrenguussing(Objects) naaziagaziadungulu
= 1 = ) Y . = .
q‘ijﬂ"llfNﬂm’c‘f FAURDAZADADIVUAUTUUA n151niles (Encapsulation) N13@UNDA (Inheritance)

N3 ﬁﬂﬁg‘ﬂ (Polymorphism)
uIAAveIM 315U 33T 130G (OOP Concepts)

1. m3niles (Encapsulation) Aenssunguuesdoya tagnquuedlisunsy e
msilnileanazi@ennouausa
9
2. M3AUNOA (Inheritance) Avmsonlii 1114 uIeeuvvIMALN VD AR
9 J
3. MINDIG 1| (Polymorphism)
. dd‘ = %3 1 % A 1 %
- Overloading waiﬂmﬂmmamu LL@liTc’Jﬂ’IiGITILL‘]J’i (Parameter List) ANU

4 U Y 4 g 1
- Overriding %0 11sunsy uazausimilouny iNeWeu behavior Yua 11l

2. Android Application
A oA o A o a oA 4
ﬂﬂi‘ﬂiL!ﬂill“]ff)‘l/\lLL’JTVIQﬂWﬁlllﬂ?)f)ﬂl!‘U‘UlﬂLWE]VINNJ‘]JL!i%‘U‘U‘ﬂ;]‘U@lﬂﬁLlﬂuﬂiﬂﬂﬂ

=2 [ Y I o a oa s 1 &
*ﬂ\iﬁﬂl'l‘iﬂﬂ%‘]'luulﬂﬂufgﬂﬂiﬂ!‘VWI”Iﬂu‘1Jui%‘UUﬂj‘]ﬂﬁﬂﬁllﬂuﬂiﬂﬂﬂmTuu

d
Tasea9lvla Android Application
A P s A ] & A a ¥ L. 3
ﬂﬂIﬂiQﬁﬁNﬂl@ﬂWa 1 developer ISUDUNUINIUY LUDIVINLIDT user AAAN application N
< 1 Jd I 1 {9 o 1
vzuua apk Wiee dimier TasTaseadieldannandsigimummuaz lidesaseez 1sioq
4
A v A

1 9
1@ 11194910 Eclipse 3319 laseas1a lvdmari inlilasdalisia Taglasaasralild et

1. /st/PACKAGENAME/ACTIVITY java (3uIWldRdwWanndes program syl 1ile 1w

2 9 o

— . v
FuAniau Tas PACKAGENAME NAo%® package NAWAINAII ag ACTIVITY
A A A Yo A 9
ADWD class ‘1/]@, GMHWiZHiH@@HﬂﬁiN
) v I J . . A A 1
2. /assets ﬁTﬂi‘ULﬂ‘Uhl,‘Na multimedia 130 U] LBU NIW LWDN a4
) v I .

3. /res/drawable 1M TUMNUANIN , icon

o o <3 S [P A o =
4. /res/layout 1INy XML U],‘V\la‘l/]‘]J\‘l‘]JE]ﬂﬂ15!,Lﬁﬂ\1Nﬁ VliJlIﬁ"J‘L!LﬂEJ’Jﬂ‘U program a8

Y o v v = 1 =
lli]ﬁﬂ’ii‘]ﬁ]@ layout LWENBYINAYY
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A Yo [

) [ <3 [ 49! = k) dy
5. /res/value M TVNUAIAI NENAUIUTEMATUIN F91l5znoVA8aIT
I 1
- /res/value/arrays.xml Wumsdszmera array
< 1
- Jres/value/colors.xml (Humstsemeaaa
I o 1
- /res/value/dimens.xml 11umM31lszmavIAInga1a9
< o o
- fres/value/strings.xml (Humstsematonny viseddmiade
I
- /res/value/styles.xml Wumsilsene object style
=~ J . =2 & ° ' . v
6. /gen/PACKAGENAME 2% 1d Rjava Hailumsmvuaa1ued object @199 lag
@ 1 c{y 1 o o'y 1 g}a i~
avienun linasud lu'lwail ims12a1 Eclipse 9291015 compile TWdt Inainnaianiinig
Y v 9
uft lvoguan

o Y a

do o A 3 a N 4 3 s
Taddgyndwannszdesinanilunieeie ACTIVITY java iiosnindulvanmums

o Y o 1 o = a'dy o
e ldsunsuerd Tagaz i191ug iy /reslayout/XXX.xml Fado vativgiiau
1 o A I v o 1 Y . o Y A v 9 =
saunu i xml Hudrtadiuuaaina 1dd java 3imie content 11 lad1 11 1w

xml 3¥1) Ta® content ’Oﬁ]ﬁ]zl’lﬁliﬂmﬂﬂﬁﬁWu’Jm"UENI‘]Jiil,l,ﬂill ,database, strings.xml 'ﬁul@s]j %uag
Suns@ouTisunsy java iiedemldlluaamaiiiie

dmsusnlidididyfe AndroidManifestxml  Fuouiailon configuration Vo<
wowwdindu Tasezifiumiiteen ﬂmﬁ’ﬂ‘ymzmamawwSmcﬁumﬂi’ﬁ’wm Saust version i

Jq 9 = .. !
oyanaliigan liauds msve permission A199

15219NV09 android application developer
Y
pamuMIRAaz My sl
R { 4 < 1 < J
- Activity aeldsunsuniivthveuaaina e ly user iy ludnazidlu nud,
a A~ ' 9 .. o A~
pownwalmdFURNMIAs UAUDIRDA 1Y TAY activity 1271IMRWIZINETNTAOUAUDS
¥ 1 g v < o A
A lFmniu mindl1een nagrgaiud
- Service Apmsiumuun lifinda uazlideants msTdaeunudld wu mp3
A ] < [ Y= 9 o I . [ o A
player 13819 user nage nAdTazdalanadla 39de ety service AovadINT
activity gnilalaudn
- Broadcast receivers ADANHMULIMIOUNITUI state AIUANVDUATOIOONNT 1ABIY
1 1 v Do 1 [ Y [ 9
dameonuunes Inseenfunsuly ualudals user Tnons 19U batter low 17 uay

(3

~ o A ' ' a A A I v
SUAINITU LW@L@']Ulﬂllﬁﬂ\jwaﬁ@ LU LAY 11T led NTEWIV Lﬂuﬁu
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. A A 1 o 9 dy % A Y 1 A
- Content providers ADHTWIUNITLFOUADITUAIUDYAIUDHINU iwel¥luniseunse

dunaunlFsanusae'li

3. Sign (digital certificate signing)
fAom 3 1n Application Inangiuvesdvaiin Taenisld profile vosdwarnd 111

Application

4. KeyStore

Qlél

A 1oAq <3 g’/ ] 1 A d g’; Yy a 9
Aouvaan 19 lumsiny key aquaviiaadull Tasuaas key Mnuluiinazeradanae

A . = A Aq v g 9
¥® Alias KeyStore Nlﬂd‘iﬂmﬁilﬁluwQdﬂmllﬂﬂiﬂflﬂﬂﬂﬂgllﬁ]ﬁQWHﬂE]‘L!

5. Force Close

=) C S v o 493 A a2 9Y A
Aemstanutlaldsunsy Unnavuiie TlsunsulivoNanaln

6. Google play
A < oA a ] A = 1T 9 & = v
ﬂﬂl?lﬂul,ﬁliﬁ‘ﬂiﬁuﬂiﬂ'lﬁﬁtﬂﬂ‘] 819N Google HagLaIuITIuNU F91lsenovaie
% g s @
Google Music, Google eBookstore 3 ﬁllﬁQGoogle App(Android Market) Futluaarayensiuas
i A 1 Pl a < ' A 9 A o
VB Android mmmamnuiwammwWam%umﬁqzwai%uuqﬂmmwmmuuu
Aa oA ¢ = a d Aa 9 E4 g’/ == éy./ ~ 9 d’l ~
igﬂﬂﬂgﬂﬁﬂﬁllﬂuﬂiﬂﬂﬂ %QLE@WWE‘ILﬂ%H%NiWﬂTJHT‘Hﬁﬂu‘u NUNUUUUNABDIYDUASLHUUN

Tudeudea g

}/' Google play

Sal
=iy
=).

v.1 Fydnuaives Google play
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ﬂ Google Play

Play Apps
Over 50% Off

' P #2:% | Just Forgot -
Chmce‘ L ,unumm-
" DceanhouseM.. &

L kkkAd USS0.49

Over 50%
Off

08  WHERE'S

$ a @ 4
sl .2 weNNANTUGoogle play VUInFAINAN

g, o coog ey Lo |

.,' Google play _——

3 < ¢ 4 = ¢
sUf 4.3 AuladGoogle play DuATDIRBNNINDS

7. daudeﬂizamﬁuéﬂ% (User Interface)

'
A 1 =

Ay 99 Y Yy Y Y o w A 9 Yo ) g ¥
Apduny 13114 Tunmsnsziinuszuy e ldihaumunnudesnisved 14

[ I [ g
us0da lalu 2 dsznn aail
' Ao ¥ 9 A ' < = 1A .
- @uimhveyail WIeAIUAINUY (38171 dUNA (input)

~Aq 9

! o A Ay ¥ o & Y 1 s
- TIUN LBUTAINDAND Wi@ﬁ?uﬂqjiﬂﬂTﬁﬂﬂWﬂmsﬁ 138NIN L’f)']ﬁ‘V!@ (output)
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8. Bug
o 1 ~ " v Y A @ A 9 a ] a 4 A
11910171 Bug Nnudanainerseauuag mm"lﬂﬁﬂagclumm relay UDUATDI
a 14 o Y o o 9 =2 A a dg! o @ A
ADNNIANDS Mark IT 1 1¥Msiauvadeg ﬁiJ']EJﬂQ‘]jﬂluTi'Wllﬂﬂ"Uuﬂ‘UIﬂ‘iLLﬂiﬂJ@uLuENiﬂﬂWﬂ

a

v Y v
daluTdsunsuniu 9 109 FehldnsiauvesTdsunsuy ligndes ideianaia nio i

=

oA - [ 9 I P v W A I Y
TTUTUNINAIT uf]ﬂi]’]ﬂﬂﬂ]uﬂ']lﬂﬂ’)ﬂﬂiﬂﬁllﬂinuaﬁ 'E']’lmﬂu‘]jiyﬁ']lﬂﬂ?ﬂﬂﬁjlﬂﬁ@\?ﬂllﬂ

9. Debug

A 1
ﬂi’)ﬂﬁ@ﬂi?’ﬂﬁ@‘ﬂLLfﬂﬂJ’gﬂ‘]JﬂWﬁﬂQﬂlﬂﬂI‘]Jil!ﬂiiJ

10. .APK

= 4 4 ) @ a o a o 4
ﬂ'f)hl,wa‘l/\lﬁlillll‘ﬂﬁ'lﬂi‘ﬂﬂ'li Install LL@WWQLﬂ%HUuﬁ%UUﬂ;]U@ﬂ'lﬁllﬁ]u@]iﬁ]ﬂ@

11. Android Platform

a oa J
Ao Android OS %3032 UUUHUANTHOUATOHA

3 o v @ 4 1
M3197 .1 ANUTUWUTYOI API level N version Y09 android uaz%agu

Platform Version API Level VERSION_CODE
Android 4.0.3 15 ICE_ CREAM SANDWICH MR1
Android 4.0, 4.0.1, 4.0.2 14 ICE CREAM_SANDWICH
Android 3.2 13 HONEYCOMB_MR2
Android 3.1.x 12 HONEYCOMB MRI1
Android 3.0.x 11 HONEYCOMB
Android 2.3.4 10 GINGERBREAD_ MRI1
Android 2.3.3
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M3197 9.2 ANUFUNUTUDI API level M1 version U9 android LAz HOFU(@AB)

Platform Version API Level VERSION_CODE
Android 2.3.2 9 GINGERBREAD
Android 2.3.1

Android 2.3

Android 2.2.x 8 FROYO

Android 2.1.x 7 ECLAIR MRI1
Android 2.0.1 6 ECLAIR 0 1
Android 2.0 5 ECLAIR
Android 1.6 4 DONUT
Android 1.5 3 CUPCAKE
Android 1.1 2 BASE 1 1
Android 1.0 1 BASE

12. API (Application Programming interface)

A 1 < g‘» A d' Aa oA A Y Aa 9 d%}
ﬂ@ﬂijll‘llf]\?ﬁ\?‘lfu YUADU 1I9AAH (Class ) ﬂi%ﬂﬂﬂ{]ﬂﬂﬂﬁﬁ‘iﬂ?ﬁﬁﬂiﬂﬁ TINUUUN

v J

iesesumsiionvedoyaninTsunsudua TaoAPI level vo95zuDURUANTIOUATOBRDE

1 a

I o A Y =3 k . I (% o
L‘]Ju@')‘ﬂﬂﬂﬂ‘lﬁ‘ﬂi"lllﬂﬁ version U®N Android Platform Iﬂﬂﬂglﬂuﬁ?iSUQTLLﬂWWﬁLﬂ%u%z

3

137130191049 Android Platform 0215 1az¥3e IA1ua11300819'15 1ag framework 199 API

- ﬂfjﬂJsU't‘]Q packages & classes A

1 Aq Y 9 =2 o 1 .
- NEUU9I XML 1/]1"]511!ﬂ'l§'ﬂ]']ﬂ3‘1/15‘1/‘|ﬂ']ﬂ5ﬁ1\‘1ﬂ 118 manifest file
- NQUYDY Intents

NQUUBIMAIUNTVDDYYINAI
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